TUTORIAL:
DESIGNING A BUSINESS CARD

Even in this supposedly “electronic” age, business cards
(or visiting cards, or address cards—if you don’t want to

sound too business-like) remain popular. This little piece
of cardboard is a reflection of your—or your organization’s—personality, a little
presentation of what you consider most important about you. So, not surprisingly,
the design aspect of this small item of stationery is very important. Like in a
three-line haiku, you have a very limited space to make a clear, original, and
memorable statement.

For the same reasons—simplicity, limited space, and the need for the
design to stand out—a business card is a perfect test project for such an essen-
tial designer’s tool as a vector editor. Inkscape’s toolset makes it a great tool for
the job; its only real weakness is the relative difficulty of creating print-ready
output files with device colors.

The steps of this tutorial show two quite different sample designs, but I'm
not inviting you to follow them exactly (unless you just want to learn the tech-
niques). If you plan to design a real business card, try to find and analyze a lot
more examples than these two, and play with Inkscape to come up with something
that combines the best features you’ve seen with something completely original.
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19.1

Chapter 19

Creativity cannot be taught, but it can be inspired. My examples are both
somewhat on the artsy side; perhaps what you have in mind for your own card
would be more traditional—but the general approach would be the same.

Design 1: Template and Text

The first step is straightforward. Create a new document by choosing the template
called business_card_90x50mm from the File » New submenu. (If you need a
different size, you can always change it in Document Properties, .) Then
switch to the Text tool and create text objects for all the text lines you will display
on your card—name, position, address, phone, etc. Make them all independent
objects (click and type each one separately) because you’re going to move them
around a lot, trying different layouts. If you will display a logo on your card,
import the logo file (Appendix B) and, if you only have it in bitmap format, trace
it ( ) to convert it to paths.

Phone 123 4567

Dmitry Kirsanov
www.kirsanov.com

12 Address 27 ) )
City dmitry@kirsanov.com

Country

Figure 19-1: Preparing the workspace and adding text objects

The next step is choosing font(s) for your text objects. A font you like will
go a long way towards a design you like, too. If you’re serious about design, you
likely have a large library of your favorite fonts; otherwise, a few basic (but good)
fonts usually come with your operating system. Many high-quality and free (or
inexpensive) fonts can be found on the Web.

I have long liked the free font called Gentium;' its main feature is good
Unicode support, but I also find it aesthetically pleasing, so I decided to use it
for this design. After you assign the font to all the text strings, play with their
relative sizes by resizing them in Selector (Figure 19-2). Do the different sizes of
the same font look good together? Strangely, that is not a given—and if
not, you will need to use different fonts for different elements. In any case,
however, never use more than two fonts in such a small design—it will likely look
too motley.

To make Inkscape see a new font, just install it as you usually do in your
operating system and restart Inkscape. The new font will be listed in the Text
and Font dialog as well as in the Text tool’s drop-down list ( ). Supported
font formats include TrueType, Type 1, and OpenType.

! Available at http://sil.ong/~gaultney/gentium
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Figure 19-2: Fonts and sizes

19.2 Design 1: Layout

Designing a business card for a single person (as opposed to creating a template
to be used by many cards with different names) has an important advantage:
You can position and align your text objects precisely, without having to leave
extra space for variable-length names and addresses. In this case, I was able to
push all the address bits closely against the name, creating an asymmetric com-
position tightly bound together by its alignments (the address is aligned with
the start of the last name, the email with the top of the name, etc.).
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Figure 19-3: Laying out the text

This already looks interesting—but perhaps a little too rectangular. An
obvious thing to try is to select all () and rotate a bit (press m once).
Much better! The design now has a flair of constructivism—a shortlived but
influentional movement of the 1920s whose proponents loved bold contrasts
and running texts at an angle (though they probably would not have approved
of the Gentium font). Let’s develop this style; add three black corners intruding
into the composition from the edges and place a big red circle in the mass center
of the composition, as shown in Figure 19-4. (Constructivists loved simple geo-
metric forms in black and red!)

To look their best, most text objects require adjusting of letter spacing
(uniform spacing between all letters in the text) and kerning (intervals between
some particular letter pairs). In the Text tool, use [Alt-<, to change letter
spacing and |Altarrows to change kerning at the text cursor ( ). Generally,
large text objects look better with tighter letter spacing, while small type needs
increased letter spacing for readability.
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Figure 19-4: Rotating and adding shapes

19.3 Design 2: Graphic

Chapter 19

Our first business card attempt was mostly inspired by a layout of the text lines,
with graphic elements coming secondary to support and reinforce that layout.
Could we go the other way around, starting from some piece of graphic and
building the design around it?

Of course, if you're doing a company business card, the obvious starting
point is the company’s logo. If you’re designing a card just for yourself and want
it to be more personal, you can try tracing (18.8) an imported photo of yours.
Finally, you can also use a piece of clipart, for example from hitp://openclipart.org
(1.3), which has many decorations and abstract pieces that might become the
centerpiece of your card.

For my second demo card, however, I chose another approach: artistic initials.
I switched to the Calligraphic pen, set the Angle to 90 degrees with a Fixation
of 100 and drew a couple of intertwined letters. After I finally got the lettershapes
more or less right, the result was mildly interesting but far from exciting. I then
tried to improve it by creating a union of the path objects and then simplifying,
insetting, and outsetting it a few times:

original drawing (5 strokes) unioned, inset/outset, simplified
Figure 19-5: Creating initials

Now the letters look more natural—but they can still be made much more
interesting. The general rule of modern design seems to be: Don’t be too neat!
If you can dirty, distort, or damage your art in a creative way, go ahead and do
it. So I selected a somewhat narrower pen nib, maximized Tremor to 100 and
danced wildly around the letters with my tablet pen (though this could just as
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well be done with a mouse). At first the result may appear rather unattractive,
but this is because I forgot to do the usual Simplify/Inset/Outset magic to it:

“dety” trermored strokes added pricaneadd, el foutuet, wrrplie

Figure 19-6: Damaging the lettershapes creatively

19.4 Design 2: Layout

Naturally, such a piece of distortion art deserves the central place on the card,
with the rest of the stuff being placed symmetrically around it. I used a plain,
slanted, very light sans serif font (Helvetica Condensed Light) which does not
distract from the artwork in the center. The horizontal layout may not be the
best here—the card seems to be cramped. Rotating everything on its side (press
(Crl-[)) gives ample space to the art and allows the text to float to the edges so it
does not interfere:

www. kirsanov.com

Figure 19-7: Laying out the card around the initials

19.5 Design 2: Texture and Color

Something is starting to emerge here, but it’s far from being ready. The card
looks too empty, too flat, too hostile to the irregular blotch of ink in its center.
Can we do something about it? Let’s try adding some background gradients. As
explained in , the default gradient from opacity 1 to opacity 0 of some color
(for example, blue) looks crude and unnatural, its boundary clearly visible even
if it uses a very pale color. To improve the look of a gradient over a white back-
ground, paint the transparent end of the gradient white, instead of the same
color as the other end.
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Here, I added four rectangles with irregularly slanted bluish green gradients
at the edges of the card to achieve a naturally curly, softly blended, asymmetric
look. The dashed lines are the bounding boxes of the four rectangles with gra-
dients, and the gradient lines show the span and direction of each gradient. I
painted the initials dark blue and added a blurred, 50% opaque drop shadow
to the letters (Filters » Shadows and Glows » Drop Shadow).

Figure 19-8: Adding gradients and shadows

Can it be still improved? A good way to add texture to the card is by overlay-
ing a regular grid of semitransparent lines. Draw a rectangle over the entire card,
open Fill and Stroke (), switch the fill to pattern, and choose the Stripes
1:1 white stock pattern. Now, using pattern adjustment handles in the Node tool
( ), rotate the strips and scale them down according to taste. Finally, move
the rectangle over the gradients and the initials but below the text in z-order,
and reduce its opacity to 20%.

Figure 19-9: Adding striped texture: The card is ready.

19.6 Export and Printing

We now have two decent business card designs—but how do we actually get them
printed? The best course of action depends on the nature of the design, and
you must understand the current limitations of Inkscape and the capabilities of
various output formats (Appendix B) to identify the best approach.
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19.6.1 PostScript

The first (“constructivist”) design does not have any transparency or gradients;
itis a collection of fully opaque shapes. This means it can be saved without any
quality loss as PostScript or EPS, which most print service providers will accept.
To be on the safe side, preview your PS or EPS output file using Ghostscript.*

Or, you can directly print such a file to your local printer device by the File » Print
command, which sends the PostScript rendition of the document to the printer.

19.6.2 PDF

For more complex designs, the best output format is PDF (B.3). These days,
nearly all print service providers accept PDF, often in preference to PostScript.
PDF is a more powerful format by itself and it is better supported by Inkscape;
with it, you don’t have to worry about gradients or opacity. Filtered objects—such
as the initials with a drop shadow in our second design—uwill be automatically
rasterized on export to PDF if you enable this option in the PDF export options
dialog.

Generally, the safest strategy for preparing your design for print is to separate
the necessarily vector elements from those that can be rendered into a bitmap.
For example, text (especially using small-size fonts), logos, and crisp foreground
shapes must remain vector; avoid using filters on them, but separate them into
a foreground layer and convert all texts to paths so they do not depend on the
availability of the fonts. Anything else (background shapes with or without
transparency, filtered objects, imported bitmaps, etc.) can be collectively pre-
rendered into a single bitmap with Make a Bitmap Copy: Set the desired resolu-
tion in Inkscape Preferences (Bitmaps page), select all the objects to rasterize,
and press [Al-B], after which you can delete or hide the vector originals. Thus, an
“export-hardened” file—with best chances of being exported to PDF, imported
into other programs, or printed without loss—would typically have just two layers:
one with bitmap-like artwork rendered as one large bitmap and the other with
vector-like artwork all in paths.

19.6.3 Bitmap Ovtput

As a last resort, if even PDF doesn’t cut it, you can always just export the entire
design as a bitmap. Inkscape can only export as PNG, but any number of other
programs, from expensive Photoshop to the free GIMP or command-line
ImageMagick, will convert a PNG to another bitmap format, such as the old (but
still popular in the print world) TIFF.

2 hitp://ghostscript.com
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19.6.4 Using Device Colors

Often, however, what you need to send to the print service provider is not just
PDF or TIFF that faithfully reproduces the way your design looks on screen.
Instead, you need your output to use device-specific CMYK or spot colors. While
there’s some limited support for using color-managed display, you can’t export
anything except the sRGB screen color space into any output format. Until this
area is improved, you will need to use some other software to rectify this.

I'have successfully imported Inkscape-produced SVG or PDF files into Adobe
Ilustrator in order to set a spot color for some objects, after which I resaved
the file as PDF. With bitmap output, it is possible to create a device-specific CMYK
file using only open source tools; first, convert the PNG exported from Inkscape
to regular RGB TIFF, and then use the tifficc command-line utility from the
LittleCMS library’ to convert it to CMYK. You will need the ICC profile file of
your target output device for this conversion.

19.6.5 Tiled Output

If you print your cards on an office or home printer, most likely you will use the
A4 or Letter paper format instead of the business card format. In that case it
makes sense to print multiple copies per sheet and then cut it into separate
cards. To prepare a printable file, group all objects of your card, then use the
Create Tiled Clones dialog to create a 2x5 grid of clones of the group that will
exactly fit on your printable page.
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Figure 19-10: Tiling the card to fill the output page

3 hatp://littlecms.com
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